TREASURY ONLINE BANKING USER GUIDE

TREASURY MANAGEMENT

ADMIN

Table of Contents

BANMND]ANAPOUS treasurymanagement@nbofi.com.

» Qverview page 2
» User Information (View & Edit) page 4
» Account Access page 6
» |P Address page 7
» Time Access page 8
» ACH Entitlements page 9
» Positive Pay Entitlements page 12
» Reporting Entitlements page 15
» Transfer/Loan Payment Entitlements page 16 NOTE: You must select Save Changes on each page
» Stop Payment Entitlements page 17 before moving on. Once you are finished editing the
> Wire Entitlements page 18 user, select Submit for Approval in the top right corner
> Receivable Entitlements page 21 of the window. Approvals will be sent to the Treasury
» Integrated Services Entitlements page 22 Management Support Team. Approvals will be
) addressed every hour, M-F 8a-5p, except on Federal
» Creating New Users page 23 holidays.
» Account Nicknames page 25
THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

June 2024 1
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TREASURY MANAGEMENT

Ad min M enu = Message Center A Notifications © cut-0ff Times Last Login: 10/16/2024, 10:39 AM, EST & Hi, implementation (PAAZ266) ~
Use the Admin menu to view the User List, Create a DASHBOARD  ACCOUNTS -  PAYMENTS - REPORTING ~
User, edit user permissions/entitlements, and assign

Account Nicknames to accounts. User List
User List Create a User

Use the User List view to see the master list of users, Account Nicknames
edit their contact information, edit their
permissions/entitlements, and approve or reject

enrollments User List Create New User
To find a user, start typing the Login ID, User Name, or Type to fitter Q
Enrollment Status in the filter box at the top of the page.
The users available narrow down as you type until the / e
matching user remains. TM User ID = Digital ID = User Name = Status & TM Status =
Actions Drop-Down Menu telark telark Tabitha Clark Enrolled ‘) Actions -
The following options are available from the Actions iew User
drop-down menu on the User List page: testusertl Kemerias2 TESTUSER IMPL ;[T
»  View User - If the information has been previously __— Edit User
: . . TMS2024 tms2024 pport B

edited, you can select Show Unsubmitted Edits to Admin, Super User Copy User

see the changes made, who made the changes, and . . Unified User - ‘) _

at what time those changes were made. unineauser uniecuser Super User e Actions -
> l:"dl.t User - You can set permissions/entitlements, . . — . ‘) _

limits for payment types and delete users. wourie viaurke Admin, Super User e HELEE <

» Copy User - You can copy an existing user to make a

) Viewing11—150f15 - First  Previ 1 n
new user with the same access, 10 v| s prevous

permissions/entitlements, and limits.

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BﬁN[Q{]IND]ﬂNﬂPOUS treasurymanagement@nbofi.com.
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Admin Menu

Enroliment Status defined:

» New - The user has been created but not yet submitted
for approval. New users can only be Not Enrolled or
Inactive.

» Pending Approval - The user was created and
submitted for approval but is not yet approved. Users
pending approval cannot be Active, only Inactive.

» Fl Pending Approval - The user was created and
submitted for approval but is not yet approved by the
financial institution. Users pending approval cannot be
Active, only Inactive.

» Enrolled - The user setup was completed and approved
by all required approvers. This user can log on to the
Treasury application and conduct business if the
Active/Inactive toggle is set to Active. An enrolled user
can be Active or Inactive.

Not Enrolled - The user was created, but the
entitlement process may not be complete, or the
Admin is not yet ready to allow this new user to log
on. This could be a new user that has not yet started
their position. Not enrolled users can only be
Inactive.

Active - The user was created, approved, enrolled,
and set to Active. This user can log on to the Treasury
application and conduct any business they are
entitled to do.

Inactive - The user may be created, approved, and
enrolled, but Inactive status prohibits the user from
logging on. Inactive can be used for a user that is
temporarily away from their duties.

Edited - The user's account access or entitlements
were edited. Edited users can be Active or Inactive.

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BANMND]ANAPOUS treasurymanagement@nbofi.com.
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i Message Centar ‘. Motifications D cur-0ff Times Last Login: 10/16/2024, 10:39 AM, EST m Hi, implementation (PAAZ266) ~

DASHEOARD ACCOUNTS - PAYMENTS - REFORTING -

Create a User

Admin Menu

Viewing User Information

Navigate to Admin = User List,
then from the Actions dropdown
list, select View User to see the
appropriate user. Here you can

Account Micknames

scroll through the User < Back to User List
Information, Account Access, and . ”
fo P Y Implementation status actve
Entitlements options to view
specific information. User Information @ Delete User
Select Show Unsubmitted Edits to eomunt
. COURLCCoESS Name: * Implementation
view any changes that have been
made but not yet saved. You can IP Access ThUseriD:* - implementation
Submit those changes or Discard Department.  TM
o . . Time Access
All Edits, if appropriate. You are Email: * kristensmerlas@nbofi.com
also able to select Edit to modify ACH A Phone*  317.686.8661 Ext
the user information as needed or .
Delete User. Entitlements
Super User: Yes
User Limits
Admin: Yes
THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

.. BMMIND]ANAPOUS treasurymanagement@nbofi.com.
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Admin Menu

Editing User Information

Navigate to Admin - User List, then from the
Actions dropdown list, select Edit User to see the
appropriate user.

In the User Information tab, change the fields as

{ Back to User List

Implementation stus actve

Submit for Approval

Edited by Implermentation 10/16/2024 at 2:59PM

A Note: Changes have been made to this user that have not been submitted for approval. You may resume editing, submit the current edits for approval, or you may take
the option to discard all edits. Discard All Edits

User Information User Information

Account Access
Name: *

IP Access

Implementation

Ext:

@ Delete User

A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit

needed, and then select Save Changes. I R R
Department | TM

» Super Users have access to all accounts and o -~ [ preer—er———
product feature permissions enabled for the I - —
company. This includes accounts and product .
features enabled in the future. i

> Admins can add, edit, delete, and approve . " superieer
company users in the Treasury Management Fremens Acrin
channel. REFORTING -

Continue down the lefthand column to establish the S e eepere e

rest of the user’s entitlements. Follow the TRNSTERIOWPRENT T p—

subsequent pages in this guide for additional D

details.

NOTE: You must select Save Changes on each page before moving on. Once you are finished editing the user, select Submit for Approval in the top right corner of the
window. Approvals will be sent to the Treasury Management Support Team. Approvals will be addressed every hour, M-F 8a-5p, except on Federal holidays.

BANMND]ANAPOUS treasurymanagement@nbofi.com.

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or
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Admln Menu < Back to User List

Implementation status: act
Account Access P atus: Active

. User Informiation Accoun‘t Access
Use the Account Access section to o

select the accounts that the user will Account Access

. Type to filter q

have access to on the Account List page.
This will also determine which accounts IP Access Account Mumber® CIF Number® Account Mame % Account Type & User Has Access &
the user can be given product features — O
and permissions/entitlements for. s e Checking

ACH -~
Check the box in the User Has Access 8745 PAA2266 ~ NON AA B745 Checking 0
column to allow user access to a specific Entitiements B R Ry e ey O
account. .

Liseyinis XXx7578 MAAZ380  Non AA 7578 Checking O

Entitlements

A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit

NOTE: You must select Save Changes on each bution at the top of the page.

page before moving on. Once you are finished RERERILTE
editing the user, select Submit for Approval in
the top right corner of the window. Approvals
will be sent to the Treasury Management
Support Team. Approvals will be addressed
every hour, M-F 8a-5p, except on Federal
holidays.

Entitlements Save Changes Reset

TS RICCT /S AR DAY ACR T .Y

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BANMND]ANAPOUS treasurymanagement@nbofi.com.
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TREASURY MANAGEMENT

Admin Menu

€ Back to User List

IP Access Implementation  status actve

Use IP Access to create a white-list of User Information IP Access © I I
IP addresses for a user.

Account Access Available IP Addresses

Use the Unrestricted/Restricted toggle
to work with this menu. Then enter

IP Access Public I Addresses Mame

the Public IP Address and Name. Time Access 123 || 45 .| 78 .| 90 m
Use the + symbol option to add or Hen - S R e e o +
remove IP Address information on this R

list. A The save button below applies to the current tab enly. Once all tabs have been completed and saved, click the

User Limits submit button at the top of the page.

POSITIVE PAY L

NOTE: You must select Save Changes on each page before moving on. Once you are finished editing the user, select Submit for Approval in the top right corner of the window.
Approvals will be sent to the Treasury Management Support Team. Approvals will be addressed every hour, M-F 8a-5p, except on Federal holidays.

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BANMND]AN&POUS treasurymanagement@nbofi.com.
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Admin Menu

Time Access

Use Time Access to set times during
which the user will have access to login
to the Treasury system.

Use the Unrestricted/Restricted toggle
to work with this menu. Then enter
the Access Type and Begin/End times
where applicable.

If the same Access Type applies to all
weekdays, you can conveniently select
the checkbox for Apply to all
weekdays.

< Back to User List

Implementation staws active

User Information Time Access @
Account Access
Day Access Type Begin End
IP Access
Monday Allowed time range ¥ 08 - 00 AN 05 - 00 PM I U Apply to all weekdays I
Time Access
Tuesday Allowed all day -
ACCOUNT RECONCILIATION
REPORTING ~
. Wednesday Allowed all day -
Entitlements
ACH ~
Thursday Allowed all day -
Entitliements
Friday Allowed all day -
User Limits
~
RCSHIVEESY Saturday Allowed all day -
Entitiements
Sunday Allowed all day hd
REPORTING ~
Entitiements
A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit button at the top of the page.
TRANSFER/LOAN PAYMENT -

Save Changes Reset

Entitlements

NOTE: You must select Save Changes on each page before moving on. Once you are finished editing the user, select Submit for Approval in the top right corner of the window.
Approvals will be sent to the Treasury Management Support Team. Approvals will be addressed every hour, M-F 8a-5p, except on Federal holidays.

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BﬁNMIND]ANﬁPOUS treasurymanagement@nbofi.com.
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Admin Menu

ACH Entitlements

Start by assigning ACH Company Access to the user by selecting Manage ACH Companies. Then use the checkbox to assign ACH Company Access.

Select Save.

< Back to User List
Implementation sutus: actve

User Information

ACH Entitlements

Account Access

ACH Company Access:
IP Access

Restricted Batch @)

Time Access
ACH Templates

ACH ~ Create ACH Template

Toggle row O
Entitlements

ACH Payments
User Limits

Full Edit ACH Template Partial Edit ACH Template

Manage ACH Companies |

[m] [m]

Save Changes Reset

THE NATIONAL

BANKZANDIANAPOLIS

Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

treasurymanagement@nbofi.com.

Manage ACH Company Access

Create ACH Payment Full Edit ACH Payment Delete ACH Payment Approve ACH P}
Search Available ACH Companies Q,
POSITIVE PAY ~ Toggle row O @] O O
Entitlements Recipients ID Company Name = Company ID =
Create Recipient Edit Recipient Delete Recipl
REFORTING ~
S — a o o NBI TM 1000000444
Entitlements Revi
eview O PENMPROJECT 01-11111 1
TRANSFER/LOAN PAYMENT A AcH Nortification of Change
Togglerow o O PENNPROJECT2 01-1111111
Entitlements
—
UsSerlTNiz | A The save button below applies to the current tab enly. Once all tabs have been completed and saved, click the submit]
STOP PAYMENT - Save Cancel

SEC Code =

CCD, CTX, PPD

CCD, CTX, PPD

CCD,CTX, FPD

Entry Description =

PAYMENT

PAYMENT

PAYMENT

Discretionary Data =

NBOFI TM TEST

ACH TREASURY TEST

ACH TREASURY TEST

OCTOBER 2024
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Admin Menu

ACH Entitlements
ACH Entitlements

ACH Company Access: NBI TM, PENNFROJECT, PENNPROJECT2 Manage ACH Companies

Restricted Batch gives the user the ability to restrict batch >
payments and batch approvals from the view of other users. I

ACH Templates

ACH Templates Create ACH Template Full Edit AGH Template Partial Edit ACH Template Delete AGH Template Approve AGH Template
» Create ACH Template Toggle row O O O O o
» Full Edit ACH Template — the user can edit information within a template.
> Partial Edit ACH Template — the user can only edit amounts, prenote, and hold ACH Payments

Se|ecti0nS, and edlt addenda information‘ Create ACH Payment Full Edit ACH Payment Delete ACH Payment Approve ACH Payment Partial Edit ACH Payment File Upload Edit
» Delete ACH Template Toggle row O O 0 o o O
» Approve ACH Template — requires action by the financial institution. B
ACH Payments recens —— —— — —

reate ipient it Recipient lete Recipient ipient
» Create ACH Payment ’ ’ ’ A
» Full Edit ACH Payment — the user can edit scheduled and recurring payments. Toggle row O O O O
» Delete ACH Payment Review
> Approve ACH Payment ACH Noification of Change ACH Returns
» Partial Edit ACH Payment — the user can only edit amounts, prenote, and hold
. . . Toggle row ] O

selections, and addenda information.
> File Upload Edit — the user can clear a batch within a multi-batch ACH upload

file during the initiation process. A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit button at the top of the page
Recipients
» Create Recipient Save Changes [CEES]
» Edit Recipient
» Delete Recipient
> Approve Recipient — requires action by the financial institution. NOTE: You must select Save Changes on each page before moving on. Once you are
Review — COMING SOON finished editing the user, select Submit for Approval in the top right corner of the window.

» ACH Notification of Change

. . Approvals will be sent to the Treasury Management Support Team. Approvals will be
» ACH Returns (currently available in eStatements)

addressed every hour, M-F 8a-5p, except on Federal holidays.

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BMMIND]ANAPOUS treasurymanagement@nbofi.com.

OCTOBER 2024
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Admin Menu

< Back to User List

ACH User Limits (DAILY) Implementation  stus actie

Edited by Implementation 10/17/2024 a1 1:32PM

Product Daily Limit is assigned by the

H H H H H H Note: Changes have been made to this user that have not been submitted for approval. You may resume editing, submit the current edits for approval, or you may take the option to discard all edits. Discard All Edits
financial institution and is not an o

editable field. If this limit needs

. User Information ACH User Limits
adjusted, please contact your Treasury
M a n age m e nt Offi Ce r Account Access Product Daily Limit §100,000.00
IP Access Daily Initiation Limit: 515.00
Daily |nitiati0n Limit, iS the Iimit When Time Access Approval Limit: $15.00

creating ACH batches. acH A

Entitlements Type to filter Q

Approval Limit, is the limit when T — p—
- Name = D= SEC code = Description = Discretionary Data = ACH Company Limit = Transaction Limit = Daily Limit =

approving ACH batches that are in

Pendi A | stat ROSTINEERY & NEITM 1000000444 ggg‘ CTX, PAYMENT NBOFI TM TEST 309'999'999999‘999 ge $0.00 000
endaing Approval status.
Frifiements PENNPROJECT  01-1111111 ggg‘ T PAYMENT ?::TTREASURY $10.00 000 5000
. .. . .. REPORTING ~
The Transaction Limit a nd Dally Limit PENNPROJECT2  01-1111111 sgg‘ CTX, PAYMENT :E:TTREASURY $15.00 $0.00 $0.00
must also be assigned for each available Friements
AC H CO m pa ny' TRANSFER/LOAN PAYMENT A A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit button at the top of the page.
Entitiements
Rl il S Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BﬁNMIND]ANﬁPOUS treasurymanagement@nbofi.com.

OCTOBER 2024
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Admin Menu

Positive Pay Entitlements
Check Exceptions

Upload/Create ARP Files

» Allows the user to
upload issued checks for
Positive Pay.

Download ARP Files

» Allows the user to work
with, view and
download Positive Pay
reports for issued and
decisioned items.

Work ARP Exceptions

» Allows the user to
decision Positive Pay
exception items.

THE MATIONAL

BANKZANDIANAPOLIS

< Back to User List

Implementation stws: active

Show Unapproved Edits

Submitted For Approval by Implementation 11/16/2024 at 7:.52PM

A Note: This user is Pending Approval. No updates to this user can be made at this time.

User Information Positive Pay Entitlements

I Check Exceptions =~ ACH Exceptions ~ ACH Filters I
Account Access

IP Access

Type to filter Q
Time Access
Account Number < Account Name < Upload/Create ARP Files
ACH ~ 5987 5987
8745 NON AA 8745

Entitlements
User Limits

POSITIVE PAY ~

Entitlements

Download ARP Files Work ARP Exceptions

Questions? Please contact our Treasury Management Support Team at 317-261-0333 or
treasurymanagement@nbofi.com.

OCTOBER 2024
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Admin Menu

ey ® . % Message Center @No ifications O cut-0ff Times Last Login: 10/23/2024, 02:05 PM, EST & Hi, implementation (PAA2266) ~
Positive Pay Entitlements BRI ANAPOLIS e o ! e e
ADMIN ~
ACH Exceptions < Back to User List
Implementation stats: Active Show Unapproved Edits
Work ACH Exceptions Submitted For Approval by Implementation 11/16/2024 at 7:52PM
> Al |OWS the user to deCIS|on A Note: This user is Pending Approval. No updates to this user can be made at this time.
ACH exception items.
User Information Positive Pay Entitlements
I Check Exceptions =~ ACH Exceptions = ACH Filters I
Account Access
IP Access
Type to filter Q
Time Acoess A nt Number = A t N s Work ACHE ti
NOTE: You must select Save Changes on : : ’
each page before moving on. Once you AcH ~ o987 o987
are finished editing the user, select Submit - 8745 NON AA 8745
. . ntitlements
for Approval in the top right corner of the
window. Approvals will be sent to the User Limits
Treasury Management Support Team.
) POSITIVE PAY -~
Approvals will be addressed every hour, M-
F 8a-5p, except on Federal holidays.
THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BANMND]ANAPOUS treasurymanagement@nbofi.com.

OCTOBER 2024
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Admin Menu

Positive Pay Entitlements

ACH Filters

Create ACH Filter

» Add and/or create filters for
authorized ACH
transactions.

Edit ACH Filter
>  Edit filters for authorized
ACH transactions.

Delete ACH Filter
> Delete filters for authorized
ACH transitions.

View ACH Filter

» View a listing of filters for
authorized ACH
transactions.

THE MATIONAL

BANKZANDIANAPOLIS

< Back to User List

Implementation saus: actie

Show Unapproved Edits

Submitted For Approval by Implementation 11/16/2024 at 7:52PM

A Note: This user is Pending Approval. No updates to this user can be made at this time.

User Information Positive Pay Entitlements

I Check Exceptions =~ ACH Exceptions  ACH Filters I
Account Access

IP Access

Type to filter Q
Time Access
Account Number & Account Name = Create ACH Filter Edit ACH Filter
ACH -~ 5987 5987
. 8745 NON AA 8745
Entitlements
User Limits
POSITIVE PAY -~

Entitlements

Delete ACH Filter View ACH Filter

Questions? Please contact our Treasury Management Support Team at 317-261-0333 or
treasurymanagement@nbofi.com.

OCTOBER 2024
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TREASURY MANAGEMENT

Admin Menu

Reporting Entitlements

CDR Balance, current day
balance reporting.

PDR Balance, prior day balance
reporting.

Date Range Balance, custom
date range balance reporting.

CDR Transaction, current day
transaction reporting.

PDR Transaction, prior day
transaction reporting.

Date Range Transaction, custom
date range transaction reporting.

EDI Report, allows user access to
view addendum information for
ACH transactions (credit/debit).

THE NATIONAL

BANKZANDIANAPOLIS

Implementation staws: active

Show Unapproved Edits

Submitted For Approval by Implementation 11/16/2024 at 7:52PM

A Note: This user is Pending Approval. No updates to this user can be made at this time.

Account Access
Type to filter

IP Access

User Information Reporting Entitlements

Q

Time Access 5987

8745
ACH ~

xxx7552
Entitlements
XXX7578

User Limits
Viewing 1-40of 4
POSITIVE PAY »~

Entitlements

REPORTING »~

Entitlements

t Name =

5987

NON AA 8745

Non AA 7552

Non AA 7578

CDR Balance

PDR Balance

Date Range Balance

CDRTI

PDRT

Date Range Transaction EDI Report

Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

treasurymanagement@nbofi.com.

OCTOBER 2024
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Admin Menu

User Information Transfer/Loan Payment Entitlements
Transfer/Loan Payment Entitlements
Account Access Type to filter a
E n t it I e m e nts fecees Create Internal Edit Internal Delete Internal Approve Internal Create Internal Edit Internal Delete Internal Approve Internal
Account Account oan Ti oan Transfer/Loan Transfer/Loan Transfer Transfer Transfer Transfer
> Create I nte rna I Tra n Sfe F/Loa n Paym e nt fime Access Number < Name = Payment Payment Payment yi p pl p! Template
»  Edit Internal Transfer/Loan Payment CZ I
ACH ~
» Delete Internal Transfer/Loan Payment . e
» Approve Internal Transfer/Loan Entitiements
Payment, requires action by the — wozssz 00
financial institution. —
> Create Internal Transfer Template POSITIVE PAY A 0T g
»  Edit Internal Transfer Template R Viewing 1- 4 of 4
» Delete Internal Transfer Template
» Approve Internal Transfer Template, REEDRTING ~ L.
requires action by the financial Transfer/Loan Payment User Limits
institution.
TRANSFER/LOAN PAYMENT »
User Limits Product Daily Limit: $9,999,999,999,999.99
» Product Daily Limit is set to unlimited by
the financial institution. UserlLimiis >
Daily Initiation Limit: $9,999,999,999,999.99 n

» Daily Initiation Limit, daily limit for
creating internal transfers.

> Approval Limit, limit for approving Approval Limit: $9,999,999,999,999.99
transfers in a Pending Approval Status.

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BﬁN[@’]ND]ANﬁPOUS treasurymanagement@nbofi.com.

OCTOBER 2024
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Admin Menu

Stop Payment Entitlements

Add Stop Payment, user can
create stop payments for
single checks and ranges of
checks.

Approve Stop Payment,
requires action by the
financial institution.

Cancel Stop Payment, user
can remove a stop payment
that was previously placed on
a single check or range of
checks.

THE NATIONAL

) BANKANDIANAPOLIS

Stop Payment Entitlements

Type to filter Q
Account Number = Account Name = Add Stop Payment I Approve Stop Payment I
5987 5987
8745 NON AA 8745

Viewing 1 - 2 of 2

Cancel Stop Payment

NOTE: You must select Save Changes on each page before moving on. Once you are finished editing the user,
select Submit for Approval in the top right corner of the window. Approvals will be sent to the Treasury
Management Support Team. Approvals will be addressed every hour, M-F 8a-5p, except on Federal holidays.

Questions? Please contact our Treasury Management Support Team at 317-261-0333 or
treasurymanagement@nbofi.com.

OCTOBER 2024
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Admin Menu

Wire Entitlements — Domestic

Entitlements must be set separately for
Domestic and International.

Wire Beneficiary

» Create Beneficiary

» Edit Beneficiary

» Approve Beneficiary, requires action by the
financial institution.

» Delete Beneficiary

Wire File - COMING SOON
» Upload Domestic Wire File
» Manage Wire File Format

Account Entitlements

» Create Domestic Wire Payment
» Edit Domestic Wire Payment

» Delete Domestic Wire Payment
» Approve Domestic Wire Payment
» Create Wire Template

» Edit Wire Template

» Approve Wire Template, requires action by the

financial institution
» Delete Wire Template

Wire Entitlements

IDomestic International I

Create Beneficiary Edit Beneficiary Approve Beneficiary Delete Beneficiary Upload Domestic Wire File Manage Wire File Format

Toggle row

Account Entitlements

Type to filter Q
Account Account Create Domestic Edit Domestic Delete Domestic Approve Domestic Create Wire Edit Wire Approve Wire Delete Wire
Number = Name = Wire Payment Wire Payment Wire Payment Wire Payment Template Template Template Template

Toggle all
Toggle

5987 5987
row
Toggle NON AA
-299e 8745
row 8745

A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit button at the top of the page.

Save Changes Reset

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BMMIND]ANAPOUS treasurymanagement@nbofi.com.

OCTOBER 2024
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Admin Menu

Wire Entitlements — International

Entitlements must be set separately for

Wire Entitlements

IDomestic International I

Domestic and International. —

Wire Beneficiary

» Create International Wire Beneficiary

» Edit International Wire Beneficiary

» Delete International Wire Beneficiary

» Approve International Wire Beneficiary,
requires action by the financial
institution.

Account Entitlements

» Create International Wire Payment

» Edit International Wire Payment

» Delete International Wire Payment

» Approve International Wire Payment

» Create International Wire Template

» Edit International Wire Template

» Delete International Wire Template

» Approve International Wire Template,
requires action by the financial
institution

THE NATIONAL

BANKZANDIANAPOLIS

Create | ional Wire Beneficiary Edit International Wire Beneficiary Delete International Wire B iary Approve International Wire Beneficiary

Toggle row

Account Entitlements

Type to filter Q
Create Delete Approve Create Delete Approve
Account Account International Wire  Edit International  International Wire  International Wire  International Wire  Edit International | ional Wire  International Wire
Number = Name = Payment Wire Payment Payment Payment Template Wire Template Template Template
Toggle
all
Toggle
S99 5ogy 5987
row
Toggle NON AA
~099E g745
row 8745

A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit button at the top of the page.

Save Changes Reset

Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

treasurymanagement@nbofi.com.
OCTOBER 2024
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Admin Menu

Wire User Limits

Product Daily Limit is assigned by the
financial institution and is not an
editable field. If this limit needs
adjusted, please contact your Treasury
Management Officer.

Total Daily Limit, is the total amount
(sum) of Wire transactions transmitted.

Approval Limit, is the limit when
approving Wire transactions that are in
Pending Approval status.

Transaction Limit and Daily Limit must
also be assigned for each available Wire
account. Amounts cannot exceed the
Company Account Transaction Limit or
Company Account Daily Limit.

Wire User Limits

Product Daily Limit: $99,999,999,999.00
Total Daily Limit: $2000 A
Approval Limit: $20.00
Filter Account Limits Q
Account Number = Company Account Transaction Limit < Transaction Limit = Company Account Daily Limit =
5987 $20.00 $0.00 $99,999,999,999.00
8745 $20.00 $0.00 $99,999,999,999.00

Daily Limit &

$0.00

$0.00

A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit button at the top of the page.

Save Changes Reset

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BﬁN[Q{]IND]ﬂNﬂPOUS treasurymanagement@nbofi.com.
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Admin Menu

Receivables Entitlements

Check the box for User Has Access to
enable single Sign On for Commerce
Capture Remote Deposits.

You must also enter the Username, which
can be found in the User Information
section of the user entitlements menu.

Receivables Entitlements

Remote Deposit Capture Entitlements

User Has Access: [

Username: * |

< Back to User List

Implementation stats: active

Account Access )
Name: * Implementation

IP Access i .
TM User ID: * implementation

Time Access
Department: ™

Email: * implementation@nbofi.com
Phone: * 317 - 261 - 0333

User Limits
Fax:

POSITIVE PAY A
Entitlements Admin —

Ext:

A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit button at the top of the page.

Save Changes Reset

BﬁN[@’]ND]ANﬁPOUS treasurymanagement@nbofi.com.

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

OCTOBER 2024
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Admin Menu

Integrated Services Entitlements

Electronic Documents, provides user access to eStatements and notices (including ACH Return notices & Analysis
Statements.

Electronic Bill Payment, provides user access to the Bill Pay module (if enabled for your company). Please see the Bill Pay
user guide for additional information on establishing Bill Pay entitlements for each user.

Integrated Services

Product User Has Access
Electronic Documents ]
Electronic Bill Payment O

A The save button below applies to the current tab only. Once all tabs have been completed and saved, click the submit button at the top of the page.

Save Changes Reset

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BﬁN[Qz’IND]ﬁNAPOUS treasurymanagement@nbofi.com.
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Ad m I n IVl e n u = Message Center M Notifications @ Cut-0ff Times Last Login: 10/16/2024, 10:39 AM, EST & Hi, implementation (PAA2266)
DASHBOARD ACCOUNTS ~ PAYMENTS ~ REPORTING ~

Create New User

From the Admin menu, select Create a User. Enter the required
information for the new user; Name, TM User ID (must be a
minimum of 6 characters), Email and Phone number.

< Back to User List

Create New User

Select if the user is a Super User and/or Admin. Definitions of user User Information
types are provided below.

Name: *

You will then be prompted for Authentication. M User ID:
Department:
In the following fields, adjust the new user's access as needed (use
the previous pages in this guide as a reference):

Email:

Phone: *

» Account Access

> |P Access Fax:

> Tlme ACCESS Super User:
> Entitlements o
> User Limits

Save Changes Reset

Save Changes and Submit for Approval. The financial institution

User List

Account Nicknames

Copy User

will contact you for verification.

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

.. BMMIND]ANAPOUS treasurymanagement@nbofi.com.

Super Users have access to all
accounts and product feature
permissions enabled for the
company. This includes accounts
and product features enabled in
the future.

Admins can add, edit, delete,
and approve company users in
the Treasury Management
channel.

OCTOBER 2024
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Admin Menu

Copy User
You can also choose to Copy User, which allows you to select a
user from the User List and copy those entitlements and

permissions over to the new user that is being created.

NOTE: By default, the new user has the same permissions as the
copy-from user.

Save Changes and Submit for Approval. The financial institution

2 Message Center ‘. Notifications @ cut-0ff Times Last Login: 10/16/2024, 10:33 AM_EST

DASHBOARD ACCOUNTS - PAYMENTS ~

& Hi, implementation [PAAZ266) ~

REPORTING - ADMIN ~

User List

Account Nicknames

< Back to User List

Create New User

will contact you for verification.

BMWIND]ANAPOUS treasurymanagement@nbofi.com.

a I Copy User ‘
Name: *
TM User ID: *
[e— Department:
Email: *
Phone: * : : » Super Users have access to all
. accounts and product feature
ax:
permissions enabled for the
Super User: company. This includes accounts
- and product features enabled in
the future.
Reset » Admins can add, edit, delete,

channel.

and approve company users in
the Treasury Management

THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

OCTOBER 2024
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Ad m | N M enu % Message Center A Notifications © Cut-Off Times Last Login: 10/16/2024, 10:39 AM, EST & Hi, implementation (PAAZ266) ~

. DASHBOARD ACCOUNTS ~ PAYMENTS ~ REPORTING ~  ADMIN ~
Account Nicknames

) LIser List
You can rename your accounts by using the

Account Nicknames menu. Create a User

I Account Nicknames I

Select the 7’ or select Bulk Edit Account Nicknames
Nicknames, enter the new name and then o _ _ _
Please provide a nickname for each account. Account Nicknames must be unique and are required.
se | eCt Save' Type to Search Q I ‘ # Bulk Edit Nicknames ‘ I
Account Number & Account Type Account Nickname &
5987 Checking 5987 ‘7‘
8745 Checking -
Save Cancel
XXX7552 Checking
Account Nickname
Xxx7578 Checking
5987
Viewing 1-40of 4
NON AA 8745
Non AA 7552
Non AA 7578
THE NATIONAL Questions? Please contact our Treasury Management Support Team at 317-261-0333 or

BﬁNKQ’IND]ﬁNAPOUS treasurymanagement@nbofi.com.
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